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Introduction 

This guide introduces the use of spatial and temporal data collection instruments 

utilizing one or more global navigation satellite systems (GNSS). A broader introduction 

to GNSS is included as additional information in the appendix. Trimble Pathfinder Office 

(TPO) companion software is typically employed in an office setting for downloading, 

uploading, performing differential corrections, and other tasks. A brief introduction to 

installation and use of TPO is included in this guide. 

Field Data Collection with Trimble TerraSync Software 

To enable field data collection, the guide introduces Trimble TerraSync software running 

a version of the Windows Mobile operating system. A Data Dictionary 

defines the attributes to be collected in the field. The 

specific field data collection mission determines the 

position, or records the inspection result of existing features 

identified in the Municipal Separate Storm Sewer Systems 

(MS4) file. 

Trimble TerraSync software has five main function 

screens accessible from a pull down menu in the upper left 

corner. 

Map - The map display shows data that has been recorded for a 

particular data file. If a data dictionary was used, the symbol 

associated with the feature is displayed. The submenu enables 

changing the display scale, panning across the 

map, measuring the distance between features, 

and placing a feature manually. 
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Data - The data display shows the data file characteristics and 

features present in the file. The submenu provides access to various 

file and feature management tasks. 

Navigation - The navigation display enables navigating directly to a 

particular feature in the data file. 

Status - The status display provides a look at 

GNSS satellite info, in real time, the status of corrector streams 

flowing into the receiver, status of external sensors like laser 

rangefinders or depth finders, and the current 

version and licensing information for TerraSync. 

Setup - The setup display provides the ability to 

change various receiver settings: logging intervals, input and output 

from real time correction servers; datum, coordinate system, and units. 

External sensors like laser range finders are configured in this screen. 

From the receiver’s Windows Mobile home, open TerraSync by clicking on Programs 

and navigate to TerraSync. Conversely, TerraSync may 

appear as an icon on the data collector’s home screen. 

Click the icon to start the program. 

The Skyplot screen under the Status menu selection 

shows which satellites (also referred to as space vehicles, 

or simply SV) are tracked by the receiver, the SV’s 

current position and signal strength. Filled (black) boxes 

represent satellites that are visible to the receiver and 

used to compute position. Unfilled (white) boxes 

represent satellites that the receiver has determined may 

be visible but the signals are too weak or below the elevation mask angle and are 

unused in determining position. The elevation mask (the point at which the receiver 

ignores low-horizon, poor-quality satellite signals) is visible as a red ring. The receiver 

antenna position is displayed at the bottom of the screen. If the satellite icon at the top 
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of the screen or its number is flashing, the satellite geometry is poor or there are too few 

satellites available to compute and accurate positions. It may be necessary to wait for 

the receiver to download updated ephemerids before a position can be determined. 

NOTE - When first started, the receiver may take 30 seconds to several minutes to 

update the ephemeris and process a valid position. This is referred to as a ‘cold start’. 

Create a new data file 

Step Instruction Image Note 

1 

Boot Terra Sync and navigate 

to the Data menu. 

 

Create a new file. TerraSync 

will request the antenna 

height. 

   Confirm Antenna Height box should be 

set to between 3 to 3.5 feet. Enter “ft” for 

feet or “m” for meters. A measuring tape 

could be used for a more accurate value. 

An external antenna will enable 

accuracies from 4 inches to a centimeter 

depending on the model of GeoXH 

receiver. If elevation is an important part 

of the job, use a range pole of a known 

length. Enter the range pole height for 

antenna height. Otherwise use a 3 to 3.5 

foot value. Tap OK. 

2 

From the Data screen select 
New. File type is Rover, data 
location is Storage Card. 
TerraSync automatically 
enters a default name in the 
File Name field.  
 
 
Use the drop-down bar to 
select (see note) the 
MS4_rev1_8 data dictionary. 
The data dictionary only 
needs to be associated with 
the data file once. 
 
Click Create after the DD and 
any background files have 
been selected. 

 

In the illustration, the Data Dictionary is 
named MS4_rev1_8. The illustration is 
likely showing an earlier version and is 
incorrect.  
 
If in doubt as to the correct Data 
Dictionary name for the project, contact 
the GTI Highway Data Services 
Manager. 
 
The filename name is specific to the 
type, time and date of your data 
collection. The filename prefix can be 
modified. A file named, R041617A, 
indicates the prefix R , 04=April, 16=16th 
day of the month, 17=1700 hours or 5:00 
p.m., A is the first file of the day. A 
default prefix can be set in the Settings 
display. Typically, the district name, i.e., 
D4- is preferred. 
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Step Instruction Image Note 

3 
The Collect Features screen 
shows the list of features 
defined in the data dictionary. 

 

 

 



5 | P a g e  
 

Record a point feature 

Step Instruction Image Note 

1 

To record a point feature, 

remain stationary over of near 

the object position to be 

recorded while the software 

logs satellite positions. When 

the software is logging SV 

positions, the logging icon     

appears in the status bar with 

the number beside the icon 

indicating the number of 

epochs logged for the feature. 

  

 

The data collector averages positions to 

determine the final position of the point 

feature. The Data Dictionary defines a 

minimum number of points to collect 

before accepting the position. 

2 

 
In the Choose Feature list 
select the single feature MS4 
Point Feature. Tap the icon. 
The attribute entry form from 
the Data Dictionary for the 
particular feature appears. 
The date attribute for new or 
for last inspection will be 
automatically entered. The 
receiver’s operating system 
date is automatically recorded 
in the field, so there is no 
need to enter a value. 
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3 

Fill in the Attributes for the 
Feature. The screens that 
follow show the features of 
the MS4/Pipes point. WVDOT 
Environmental Coordinator 
 
Notice in the illustration that 
the recorded points in the 
upper right shows zero, and 
there are no satellites or 
accuracy numbers. 

 

Discuss the significance and proper 
coding of the point, line and area 
features with the 
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Step Instruction Image Note 

 

4 

As the software logs GPS 
positions, the counter beside 
the logging icon counts 
logged epochs. Ensure the 
data collection is not paused. 
The MS4 data dictionary 
demands a minimum of 3 
recorded epochs. 

 Listening to the data collector will give an 
indication of observation accuracy. A 
rising tone indicates carrier and a falling 
tone indicates code phase. 

5 

When finished entering 
attributes, tap OK to close the 
feature. The attribute entry 
form closes and returns to 
Collect Features. 

  

 

Recording Line and Polygon Features 

To illustrate data collection of a linear feature will be the collection of the position and 

length of the guardrail in a parking lot. 

To record a line feature, carry the receiver along the line of interest. Using the Data 

Dictionary defined collection scheme of recording a data point at a distance interval 

determined in the DD definition. For linear features, it is most common to record 

positions at a logging interval of distance rather than time. 

The logging interval was set when the feature was created in the data dictionary. 

Individual points, called vertices, are joined together to form line and area features. 

Polygons are automatically closed when the feature is closed. Therefor to close a 

polygon it is not necessary to return to the starting point. 

The default data logging is also defined in the Data Dictionary. TerraSync commonly is 

setup to begin logging GNSS positions as soon as a new feature is created. The Log 

Later or Pause option is used hold position logging. Log Later is useful for filling in the 

attribute before recording positions. Pausing collection during a linear recording can be 

used when crossing a stream or circumventing a hazard without recording the 
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intervening positions. In these cases, the collection is paused, the data collector taken 

to a point on the other side of an obstruction, as the collection is restarted. 

When recording polygon features the software will log point positions specified in the 

data dictionary while walking the perimeter of the area of interest with the receiver. The 

first and last positions are joined together to close the area, it is not necessary to return 

to the exact starting point. 

1. Open the Collect Features screen by tapping the Section list> Data. 

2. Tap the subsection list button and select Collect Features. 

3. Tap Options and select Log Now. 

4. In Choose Feature from the list. Tap Create. 

5. Data logging maybe paused at any time. When finished collecting tap Close. 

6. When finished the project data collection, close the data file. From 

Collect Features tape Close. Confirm the file close dialog. 

7. To exit TerraSync, tap the Close button in the upper right corner of the screen. 

Confirm that program exit 

Re-Inspection of Existing Data Points 

The proper workflow for data point re-inspection updates existing data rather than 

creating a new point, line or polygon. Otherwise the dataset can’t be properly 

maintained and becomes increasingly difficult to map. The resulting inefficiency 

unnecessarily creates additional work for the data manager. 

The following example workflow will use the WVDOH MS4 discharger permit dataset. 

This dataset consists of drainage pipes, catch basins, and other small drainage 

structures. 
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Preparing the Dataset 

To enable navigation back to our MS4 feature do perform periodic inspections, 

several background files should be imported to help the field technician locate the 

feature. The MS4 features will be imported as waypoints to provide TerraSync with 

targets to enable navigation to particular features. Filtering the complete set of points to 

provide a list of reinspection targets is coverer in a later section. 

TerraSync can read Shapefiles, so transferring the Shapefiles into the Juno is an 

easy process.  

 
Loading the Dataset 
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Step Instruction Image Note 

1 

Boot Terra Sync and 

navigate to the “Data” 

menu. 
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Step Instruction Image Note 

 

Select “Existing” 

 

 

 

The data exported to 
the Juno should 
display as shown. 
Touch “Open” 
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Step Instruction Image Note 

 

Select the feature 
you wish to update. 

 

 

 

Points can be sorted 
by Distance 
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Step Instruction Image Note 

 

Once at the feature, 
update the fields and 
be sure to check the 
“Mark as Updated” 
checkbox. 

 

 

 

Touching the “Log” 
button will update the 
point feature. Once 
done updating touch 
the “Done” button 
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Step Instruction Image Note 

 

Touch OK to confirm. 

 

 

 Select another 
feature and repeat 
the update process. 
 
Once you’re done 
updating, touch 
Close to complete, 
OK to confirm and 
close TerraSync. 
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Data Collection with Trimble TerraSync 

The purpose of this exercise is to gather positions of selected features using the data 

dictionary and Trimble TerraSync software.  

• Collect various point, line, and polygon features around the practice area. 

• Record a line feature by measuring the position of a liner feature, such as a 

guardrail. 

• Determine the area of a section of the parking lot by recording by walking the 

perimeter as an area feature. 

• Use the map display in TerraSync to occasionally verify the features of interest 

are recording. 

Tips on Using a Trimble GeoXH and Juno Receivers 

• Understand how to read the observation accuracy indicated on the receiver 

display. 

• Turn up the system volume and listen to the tones the receiver generates. 

Understand how TerraSync software provides aural clues to assist in obtaining 

accurate positions. 

• Heavy foliage and buildings may block the receiver’s view of the sky. Try recording 

positions at later time to obtain a more favorable satellite geometry. 
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Trimble GPS Pathfinder Office (TPO) 

Ensure the latest version of GPS Pathfinder Office is installed. As of this writing, the 

latest version is 5.80. 

 

Download and install the latest version of Trimble Pathfinder Office software from 

Trimble’s Docshare website: 

http://www.trimble.com/globalTRLTAB.asp?Nav=Collection-4552, or drag and drop to 

the local machine the latest version available from the root of the District Environmental 

Coordinator’s folder: \\executive\dfs\DOTShared\publicshares\District Environmental 

Coordinators\MS4_GIS\GPS_Pathfinder_Office_v581.zip. 

DO NOT INSTALL THE LICENSE MANAGER. 

Create a Pathfinder Project 

In GPS Pathfinder Office, create a new project if it doesn’t already exist use the browser 

to traverse the path \\executive\dfs\DOTShared\publicshares\District Environmental 

Coordinators\MS4_GIS\Pathfinder with a Project Name MS4. 

Pathfinder will fill in the path and create folder for the Backup, Export, and Base files. 

http://www.trimble.com/globalTRLTAB.asp?Nav=Collection-4552


17 | P a g e  
 

 
 

Save the Backup Files to Local Computer 

1. Under the File menu, select Project…  

2. From the Project dialog box (see previous illustration) select Modify… 

3.  

 
 

Transfer Data from Juno 

The field observations will be transferred from the receiver to the office computer for 

post-processing and then exported as shapefiles or a file geodatabase for mapping. A 

file geodatabase provides the most effective organizational tool, particularly when a 

data dictionary contains mixed feature types (points, lines, polygons). Connect 

Juno/GeoxH to TPO using the Data Transfer function of TPO to connect with a field 

data collector. JunoB/C use a standard mini USB; Juno5’s use a Trimble-specific DB-9 

like connector; GeoXH 6000 and X7’s use a mini USB with a low profile (narrow) plug. 

Trimble GeoXH 2008 receivers use a cradle to interface with the host computer. Place 

the unit securely into the cradle or USB cable, ensure the USB cable is connected to the 

computer. 

After connection, a box indicating driver’s for the device should load, and Windows 

Mobile Device Center (WMDC) appears. It is not necessary, nor is it recommended to 
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setup a data collector with Outlook, Calendar, eMail or any other type of personal data, 

as many individuals may be using the data collector. 

 

1. Start TPO, and select Utilities> Data Transfer from the menu, or the data 

transfer icon from the TPO menu bar OR select the Data Transfer utility from 

Start>Trimble>Trimble Pathfinder Office> Data Transfer. 

2. Windows may take up to a minute to recognize and download the drivers for the 

receiver. From Data Transfer dialog the Device List, GIS Datalogger on 

Windows Mobile should be visible in the window. When switching transfers 

between receivers, use the red disconnect button to disconnect and the green 

button to then connect the new receiver. 
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TIP: With the Juno 5, ensure the thumb screws are backed all the way out of the minute 

snap connectors. Protruding screws on the cable end can prevent a solid connection. 

 DON’T NOT OVERTIGHTEN the THUMBSCREWS. It is not too difficult to pull the 

threads on the thumbscrews. 

3. Select the Receive tab to receive data from the device. 

4. Click Add> Data File from the drop-down list. The desired file will appear in the 

Open dialog. Select the file. 
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5. Check that the Destination field in Settings shows the correct path, then press 

Open. The open dialog disappears and the file appears in the Files to Receive 

list. 

 

6. Click Transfer All. The data file is transferred to the desktop computer in to the 

destination fold that was setup for the project. 

   

Troubleshooting the Connection 

If Windows Mobile Device Center fails to appear WMDC may not be installed. 
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TPO Export 

Data collected with TerraSync can be exported in any number of formats. Exports to 

shapefile and file geodatabase formats can be directly used in ArcMap. Of these, the file 

geodatabase is most useful. 

Export Shapefiles 

The export utility must have the export coordinate system setup to recognize a 

projection definition file. Projection definition files can be retrieved from ArcMap 10.3.1 

and later by first selecting a particular projection and setting it as a favorite. Commonly 

used projection files have been collected in the shared District Environment 

Coordinators>MS4_GIS<Coordinate Systems folder. 

The preferred file type, a file geodatabase, is elaborated here in greater detail. 

Exporting to a File Geodatabase  

When the Export utility runs, the last-used set of files is automatically selected as the 

set of input files. For example, if a set of data files was recently downloaded using the 

Data Transfer Utility, those files appear in the Selected Files list box. Also, the folder 

for the exported data is (by default) the folder specified in the current GPS Pathfinder 

Office project. Different input files or a different export folder can be selected. See the 

instructions on using the Pathfinder Office combine command for combining multiple 

SSF files before exporting. 

To export files to a GIS or CAD format: 

4. Start the Export utility. 

5. To change the list of selected input files, click Browse. The Select Data Files 

dialog appears. 

6. Select the files that you want to export and click Open. 

The files that you select must have the same data dictionary. 

dataxfer.chm::/DataXfer/Welcome.htm
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7. If you want to change the export folder, type the path in the Output Folder field in 

the Export dialog, or click Browse. The Browse for Folder dialog appears. 

8. Select the new folder and click OK. 

Note: Only specify the folder; the files created in that folder are automatically named 

by the Export utility. 

 

9. Select the export setup to use from the Choose an Export Setup field. By 

default, the export setup is the same as that used in the last session. 

A File Geodatabase is identified by a folder it is in and is collection of various 

types of GIS datasets held in multiple files in this folder. It provides a widely 

available, simple, and scalable geodatabase solution that works across operating 

systems, scales up to handle very large datasets, and uses an efficient data 
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structure that is optimized for performance and storage. 

If this is the first time export to a geodatabase, perform the customization as 

described below. 

Known limitations 

The Export Utility utilizes the Esri Geodatabase API which supports ArcGIS 10.x only. 

The SSF file format has different data types than Esri File Geodatabases. The table 

below specifies types of geodatabase fields created for SSF attributes types (these are 

all ArcGIS defaults): 

SSF type  Geodatabase type 

String  esriFieldTypeString  

Filename  esriFieldTypeString  

Numeric Dec. Places = 0 esriFieldTypeSmallInteger, Precision = 5 

 Min = -32768 

 Max =32767   

 Dec. Places = 0  esriFieldTypeInteger, Precision = 10 

 Min =-2,147,483,648 

 Max =  2,147,483,647 

 Dec. Places <= 7  esriFieldTypeSingle  

 Dec. Places > 7 esriFieldTypeDouble  

Date  esriFieldTypeDate 

  (time part set to 0:0:0) 12AM  

Time  esriFieldTypeDate 

  (date part set to 1/1/1900)  

Menu  esriFieldTypeString, with coded value domain  

• Due to restrictions of the current version of the File Geodatabase API, it is not yet 

possible to link attributes back to domains in the exported File Geodatabase. 

• Some characters in non-Western European character sets may be exported 

incorrectly. 
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• If the target ArcGIS system does not support non-Western characters in object 

names, the following workaround may provide a solution: create a data dictionary 

that has names in the Western character set and aliases in the language of the 

user, and export using this data dictionary. 

• Geodatabase Datetime data types always require date information. When 

exporting a Time attribute from a SSF file, a default date of 1/01/3800 is added to 

the attribute. This also affect the GPS Time metadata. (Note: Datetime data 

types do not require a time component, so Date attributes from an SSF are 

exported as just date data with no default time). 

• Photos are exported as paths only; images themselves are not exported. 

 

Customization for Geodatabase, UTM 17 North. 

The customization only needs to be performed on a system that has not been 

setup for the particular projection, in our case UTM17N. 

1. In the Choose an Export Setup section of the Export window, use the pulldown to 

select Sample ESRI File Geodatabase Setup. 

2. Click the Properties button. 

3. Click the Coordinate System tab. The Coordinate System dialog will look 

something like the illustration, without the Export Coordinate System button 

defined. 
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4. Click the Use Export Coordinate System radio button, then the Change button. 

 

5. Set the coordinate system and zone as in the illustration;  

System: UTM 

Zone: 17 North 

Datum: NAD 1983 (Conus).  

6. Click OK. 
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7. Click the ESRI File Geodatabase tab. 

8. Copy the XML Spatial Reference from here or from the UTM.xml.txt file in the 

Environmental Coordinators>MS4-GIS>Coordinate Systems folder. 

<SpatialReference 

xsi:type="esri:ProjectedCoordinateSystem"><WKT>PROJCS["NAD_1983_UTM_Zone_17N",

GEOGCS["GCS_North_American_1983",DATUM["D_North_American_1983",SPHEROID["

GRS_1980",6378137.0,298.257222101]],PRIMEM["Greenwich",0.0],UNIT["Degree",0.017453

2925199433]],PROJECTION["Transverse_Mercator"],PARAMETER["False_Easting",500000.

0],PARAMETER["False_Northing",0.0],PARAMETER["Central_Meridian",-

81.0],PARAMETER["Scale_Factor",0.9996],PARAMETER["Latitude_Of_Origin",0.0],UNIT["

Meter",1.0],AUTHORITY["EPSG",26917]]</WKT><XOrigin>-

5120900</XOrigin><YOrigin>-

9998100</YOrigin><XYScale>450445547.3910538</XYScale><ZOrigin>-

100000</ZOrigin><ZScale>10000</ZScale><MOrigin>-

100000</MOrigin><MScale>10000</MScale><XYTolerance>0.001</XYTolerance><ZToleran

ce>0.001</ZTolerance><MTolerance>0.001</MTolerance><HighPrecision>true</HighPrecisio

n><WKID>26917</WKID></SpatialReference> 

9. Click OK. Ensure the Export dialog window looks like the illustration. Check: 

Selected Files location and name from the TPO project folder. 

Output Folder location, suggested location is the same Environmental 

Coordinator MS4-GIS folder as the project. 

10. Click OK. 

11. If files with the same name exist in the selected folder, a warning appears. 

To avoid overwriting existing data, use the Output tab in the Export Setup 

Properties dialog to select an output option. You can output data to a uniquely 

named file or set of files, or create output files in a uniquely named folder. In 

addition, by default the Import utility generates a unique name for each SSF file it 

creates. Trimble recommends that you use these default filenames and the 

appropriate export output option. This reduces the risk of overwriting data files. 

12. Click Yes to overwrite the files, or No to select another destination folder. 

13. A dialog shows the progress of the export. 

14. Click Cancel only if you want to stop the export process. 
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15. When export is complete, a message appears, listing how many features were 

exported. 

16. Click More Details to see the detailed log file of the export operation, or Close to 

acknowledge the message and close the Export utility. 

17. The exported files are now present in the export folder and are ready to import 

into ArcMap. The exported files use a naming system appropriate for the export 

format.  

The Pathfinder Office Combine Utility 

The Combine utility is one of a series of GPS Pathfinder® Office utilities that help you 

to manage your data collection projects. The Combine utility combines two or more data 

files into a single data file. It combines (concatenates) all records from each input file. 

Combine data files so that you can edit them together. Although the GPS Pathfinder 

Office software lets you open multiple data files, you can only edit the data if you open a 

single data file. 

To combine a set of data files: 

1. Specify the input files. By default, the last-used set of files are selected as input 

files. For example, if a set of files had recently been differentially corrected (it is 

recommended that Juno SBAS data NOT be differentially corrected), the 

corrected files would be selected by default. 

2. To change the list of selected input files, click Browse. The Select Data Files 

dialog appears. 

3. Select the input files to be combined, and click Open to return to the main 

window.  
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4. Specify the output file. By default, the output file is called Combined.ssf and will 

be created in the current project folder. 

 

5. Change the file name click by clicking Output File. The Output File dialog 

appears. 



29 | P a g e  
 

6. Enter the new file name in the File name field. Select a different folder if 

necessary. 

It is suggested that these files are saved to the Environmental Coordinator’s 

MS4_GIS > District folder. 

7. Click Save to confirm your selection and return to the main window. The new file 

name is displayed in the Output File field.  

 

Select a sort method: 

8.  Select the Chronologically option to sort the data files by time, putting the 

earliest first. This is the default and the recommended option. 

9.  Select the Alphabetically option to sort the data files alphabetically by file 

name. This option may combine the input data files out of time sequence. 

10. Click OK to combine the files. 

11.  A progress bar appears and the operation begins. When the operation is 

complete a success message appears. 

12. Click OK to acknowledge the message. The Combine utility closes. 
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Differential Correction 

Differential Correction reduces the influence of propagation errors discussed in the 

Appendix. Differential correction improves the accuracy of GNSS positions by 

comparing the roving instrument’s observations made during a particular period (or 

epoch) to observations from a continuously operating reference station (CORS) during 

the same epoch. The CORS position is well known to an accuracy of several 

centimeters. The differential between the known CORS position and the position 

determined by the roving receiver can largely be considered the propagation error. 

Single frequency receivers like the Juno series should always have SBAS (space-based 

augmentation system) enabled. In the United States, the SBAS system is sponsored by 

the Federal Aviation Administration and referred to as the wide-area augmentation 

system (WAAS). With WAAS enabled and active, denoted by a solid airplane symbol on 

the top of the display, accuracies should be in the range of 3 to 5 meters or 9 to 17 feet. 

Post-processing a WAAS observation from a single-frequency receiver provides little 

additional benefit. 

Export GNSS Data to ArcGIS 

The purpose of this exercise is to export the results of the data collection and 

differentially corrected positions as a shapefile for import to ArcMap. 

When using the Pathfinder Office Export utility, the last-used files are automatically 

selected as the inputs. For example: if you had just downloaded a set of data files using 

the Data Transfer Utility, the files appear in the Selected Files list box of the Export 
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window. By default data is 

exported the folder specified in 

the current Pathfinder Office 

project. Alternate input files and 

export folder may be specified. 

1. Start the Utility menu and 

click Export. 

7. When the Export window 

appears, check the 

Selected Files list for the 

corrected file. If it does not 

appear, click Browse and 

navigate to the working 

folder to select the corrected file. 

8. Set the Output Folder path to the working folder location. 

9. Choose an Export Setup file type and system. Select the Sample ArcGIS 

Shapefile Setup. 

10. Choose Change Setup Options to correct the spatial reference system, datum, 

and units if necessary. 

11. Click OK at the top right of the Export menu. 

12. Close the utility after the Export Completed window appears. 

13. The exported files in *.shp format are in the export folder ready to import into 

ArcMap. Use the Add Data button in ArcMap to select the file(s). 
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Appendix A: Global Navigation Satellite Systems (GNSS) 

What is a Global Navigation Satellite System? 

Several Global Navigation Satellite Systems (GNSS) are presently available for 

positioning, navigation, and timing (PNT) applications. A GNSS measures the travel 

time of radio transmissions from satellites, referred to as space 

vehicles, or SV, to determine position. 

The global system sponsored by the United States Department 

of Defense (USDoD) is the NAVSTAR Global Positioning 

System or GPS. The GPS is a global radio-navigation system 

formed from a constellation of 24 satellites and supporting 

ground monitoring and control stations. Other GNSS include the 

Russian GLObal'naya NAvigatsionnaya Sputnikovaya Sistema or GLONASS, the 

European Galileo, and the Chinese Compass. 

The NAVSTAR GPS infrastructure was conceived in 1973 by the USDoD. The USDoD 

GPS mission to provide universal access to global positioning was brought into sharp 

focus after Korean Air Lines Flight 007, carrying 269 people, was shot down in 1983 by 

the USSR after straying into prohibited airspace. Then President Ronald Reagan issued 

a directive making GPS freely available for civilian use as a common good. The first 

GPS satellite was launched in 1989, with the full 24th satellite constellation completed in 

1994. Full operational capability was announced a year later. 

Russian GLONASS began SV launches their system development in 1976 with full 

operation of the system by 1995. The system fell into disrepair with the collapse of the 

USSR, however under Vladimir Putin the system was restored and upgraded. 

GLONASS SV design has undergone several major upgrades. 

GPS and GLONASS SV count and type can be viewed through any WVDOT/RTI 

continuously operating reference system (CORS) receiver. The Huntington CORS, 

designated WVHU by the National Geodetic Survey (NGS) with coordinates published 
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at NGS’s website http://www.ngs.noaa.gov/CORS, can be examined at URL 

http://wvhu.marshall.edu> Satellites>General 

 and http://wvhu.marshall.edu> Satellites>General >Tracking(Table). 

Galileo is the European Union (EU) and European Space Agency (ESA) GNSS. When 

fully operational, Galileo will employ two ground monitoring and control centers, near 

Munich, Germany, and in Fucino, Italy. An initial constellation of 18 satellites are 

scheduled to be in orbit by 2015. It is estimated that an additional €1.9 billion will be 
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required to enable a full constellation of 30 satellites. The first experimental satellite, 

GIOVE-A, was launched in 2005, followed by a second launch in 2008. 

GNSS receivers have been improved, miniaturized, and mass produced so that this 

positioning technology is accessible to nearly everyone. GNSS technology has become 

so ubiquitous that receivers are found in mobile phones, cars, boats, planes, 

construction equipment, movie making gear, farm machinery, laptops, pad computers, 

and dog collars. 

How GPS Works 

The original GPS constellation consisted of 24 Satellites in 6 Orbital Planes, with 4 

Satellites per plane, in orbit approximately 12,600 statute miles above the Earth’s 

surface, inclined 60° to the equator. In 2010 the USDoD began moving SV orbits slightly 

to incorporate additional SVs in a 24+3 configuration called Expandable 24. The new 

GPS constellation provides for an optimized geometry, maximizing GPS coverage for all 

users. 

Four parameters that are determined by the user’s 

receiver: X coordinate, Y coordinate, Z coordinate 

and the radio signal travel time from the SV to the 

receiver. These four unknown values cannot be 

determined directly from only one or two satellites. To 

solve the four unknowns there needs to be at least 4 

satellites visible to a GPS receiver to provide the information necessary to determine a 

three dimensional position fix. 
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The receiver bases its position on the distance from each satellite. In a graphical view, 

the user’s position can be thought of as laying somewhere on an imaginary sphere with 

the sphere radius equal to the distance from the 

SV. 

The standard solution for determining the user’s 

position requires a pseudorange measurement 

(apparent travel time of the radio signal times 

the signal’s speed) and an ephemeris (a way to 

determine the SV’s position) for each satellite in 

view. The position solution is corrupted due to two sources of error: 1) errors in the SV 

observations and 2) errors in the ephemeris. The greatest observation error in 

determining the user’s position is from the GPS receiver’s clock, however other sources 

contribute to position error. 

GNSS position determination is called trilateration of the SV positions. Trilateration is a 

method of determining the relative positions of objects using the geometry of the 

distance and angles between visible SVs and user position. The process is similar to 

triangulation, which is the process of determining the location of a point my measuring 

angles to it from known points at either end of a fixed baseline. 

GPS Signals 

Each GPS SV broadcasts spread spectrum radio signals at 1575.42 and 1227.6 MHz. A 

third frequency band centered on 1176.45 MHz, is available from the newest Block II-F 

SVs. The first L5 capable satellite was launched in May of 2010. It is anticipated that the 

full 12 satellite constellation of L5-capable SVs will be in orbit by 2019. These 

frequencies are referred to respectively as the L1, L2, and L5 bands. A coded signal 

available to civilians is broadcast on L1. A new civilian coded signal was added with the 

GPS Block II-RM SVs is available on the L2 band. The L1 signal contains two 

components: a time code and a navigation message. Future full implementation of the 

L5 will enable an entirely new series of consumer grade receivers capable of providing 

sub-meter accuracies. 
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At present, most consumer grade GPS receivers only receive the L1 signal. High 

performance receivers are capable of decoding the L2 signal, with the latest models 

able to decode the L5 signals. Several GPS signals are reserved for military use and 

can only be decoded by military receivers. Newer chipsets are enabling 

GPS+GLONASS capability in consumer products. 

The GPS radio signal travels from the SV orbit, through the Earth’s atmosphere. The 

characteristics of different layer of the atmosphere affect the radio signal differently. The 

ionosphere, which is the high-altitude, electrically charged part of the atmosphere, 

introduces a delay, and therefore a range error, to the signal. Ionospheric delay can be 

predicted by mathematical modeling. There is a limit to the accuracy of ionospheric 

models. Better accuracy can be achieved by measuring and remove the ionosphere 

delay error. Measurement of the ionosphere delay is possible by taking advantage of 

the fact that radio delay through the ionosphere is frequency dependent. That is to say 

the delay is predictably different at different frequencies. Dual frequency GPS 

receivers, those capable of processing the L1 and L2 frequencies, can compute the 

ionospheric delay from the difference in the L1 and L2 signals. Additional signal delay 

occurs in the troposphere. The troposphere is the lower part of the atmosphere that 

produces weather. Like the ionosphere delay, the atmospheric delay can be either 

predicted or derived from measurements. 

Other errors affect the GPS signal’s travel to a lesser degree. Multipath reflections 

occur when the radio signal bounces off a radio-reflective surface. The reflected signal 

and the direct signal arrive at the receiver at different times making it more difficult to 

the receiver to discern the correct signal. GPS positions determined by single 

frequency receivers, with no augmentation (error correction) of the SV signal are 

accurate to within five to twenty meters (16-70 feet) of the true value. Augmenting the 

SV signals with corrections that account for various transmission and hardware errors, 

and through modeling the ionospheric and tropospheric delay, single frequency GPS 

positions can be determined to a horizontal accuracy of between 2-5 meters (7-20 feet) 

of the true value. 
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Dual frequency receivers, capable of decoding L1 and L2 bands receivers. 

Additionally, dual frequency receivers measure the carrier frequency of the L1 and L2 

signals and use the phase difference between the two frequencies to help determine 

how many carrier frequency wavelengths are between the satellite and the user’s 

receiver. This method is much smoother and has less noise than a single frequency 

code measurement. Carrier-phase processing is subject to random, sudden jumps 

referred to as cycle slips. 

Dual frequency receivers, in conjunction with fixed ground-based reference receivers, 

enable horizontal position accuracies from handheld receivers to under a foot, 4 inches 

with an external antenna, and to within 1 centimeter (about half an inch) with survey-

grade receivers. 

Since determining the distance from an SV to the user’s position requires measuring the 

travel time of several SV radio signals, it requires very accurate time keeping. Accurate 

time keeping is accomplished with atomic clocks. 

Atomic Clocks 

For centuries mankind tried to discover ways to accurately reach their destination 

safely. For centuries, a navigator on the high seas could determine latitude from the 

height of the sun at local noon. However the navigator was unable to determine 

longitude. Solving the longitude problem depends on knowing how far the navigator’s 

local noon was, in units of time, from local noon at a reference longitude. Since the 

Earth completes one revolution of 360 degrees every 24 hours, a one-hour difference 

between local noons is 360/24 or 15 degrees per hour, 0.25 degrees per minute, or 

0.00417 degrees per second. One degree at the equator is the Earth’s circumference at 

the equator 24,901.5 miles divided by 360 degrees or 69.169 miles. The distance 

between lines of longitude other than the equator can be determined by multiplying the 

distance at the equator by the cosine of the latitude. For example, an estimate for the 

distance between degrees of longitude in Charleston is cosine(38.5 degrees latitude) x 

69.169 = (0.786) x 69.169 = 54.132 miles. 



39 | P a g e  
 

It wasn’t until John Harrison developed an accurate ocean going time piece over a 31 

year period that longitude could be determined for dependable navigation. It was his 

invention of the chronometer that won the English board of Longitude Act prize an 

ultimately enabled the Age of Discovery. 

In our era, it is the atomic clock, using the predictable, measurable decay of a 

radioactive source as a ‘heartbeat’, which enables accurate time keeping. Accurate time 

keeping enables a GNSS SV to generate a very accurate coded radio signal. A 

Rubidium clock exhibits a time accuracy of ±1 x 10-13, or 0.0000001 part per million, 

also expressed as a time error of 8.6 nanosecond per day. 

All electromagnetic radiation, including radio signals, travel at the speed of light in a 

vacuum, 299,792,458 m/sec or 186,282 mi/sec. Expressed the speed of light in 

distance terms, light travels 1 foot in 1 nanosecond. Using this relationship with the 

expected atomic clock drift of 8.6 nanosecond per day, an SV’s clock error contributes 

eight and a half feet of position error per day. This one of many errors continually 

measured by ground monitoring stations. When the ground monitoring station 

determines the SV’s clock drift rate and orbital path, those parameters are sent from the 

monitoring station to the SV. The SV continuously encodes the clock drift and orbital 

parameters into its radio transmission stream. The transmission is decoded by the 

user’s receiver and the corrections applied to the position calculation. 
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Other physical phenomena distort the GPS signal’s travel time. Albert Einstein’s 

Special Theory of Relativity predicts time distortions due to the high velocity of a SV 

relative to an Earth observer. An observer on the ground sees the SV motion as 8,700 

miles per hour. At one millionth the speed of light, Special Relativity predicts that the SV 

clocks tick more slowly than the observer’s clock, resulting in the SV atomic clocks on 

the SV behind the observer’s clock by about 7 microseconds per day due to the time 

dilation effect of their relative motion. The General Theory of Relativity predicts time 

distortions due to the large difference in gravity between a SV in orbit 16,500 miles from 

the Earth. The curvature of space-time due to the Earth's mass is less in space than at 

the Earth's surface. As viewed from the Earth, the clocks on the SV appear to be ticking 
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faster than atomic clocks on the ground. General Relativity predicts that the clocks in 

each GPS satellite will run 45 microseconds per day faster than the ground observer’s. 

The combination of the two relativistic effects, although one slightly offsets the other, 

means that atomic clocks on-board each satellite will tick faster than identical clocks on 

the ground by about 38 microseconds per day (45-7=38). The high-precision required of 

the GPS system requires nanosecond accuracy. A daily error of 38 microseconds is 

38,000 nanoseconds. Without accounting for relativistic effects, GPS errors would 

accumulate at a rate of about 10 kilometers (6 miles) each day. Relativistic effects on 

time are accounted for by the receiver’s programming. 
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